
Drag And File Quick Manual

This is an abridged version of the printed manual that will come with the registered version of 
Drag And File, however the help file accompanying this version is complete.

1.1 Program Description
Drag And File streamlines and simplifies the work of managing files on your computer. It offers 
several unique functions, such as a directory finder and a duplicate file finder.  Drag And File 
works at several levels of sophistication and integrates with other management and utility 
programs. The result is an uncommon degree of flexibility: Drag And File can be configured to 
meet your needs, your working style, and your experience. When you need more, Drag And File 
delivers. Unlike most other Windows file managers, Drag And File allows you to highlight 
individual files and tag multiple files, which makes possible batch operations on non-contiguous 
groups of files. Drag And File offers a broad range of file management tools:

* Drag-and-drop file move, copy, and delete
* Viewing of all text and most graphics files
* Tree and branch batch operations on all files
* Single click execution of most frequent tasks from a toolbar, including viewing
* Separate windows for each drive
* Full hot key control for hands-on keyboard execution

Drag And File displays a window complete with toolbar and menu choices for each drive selected.
You may open up to 12 drive windows simultaneously. The entire program can be run from a 
single small Drivebar which floats unobtrusively on your screen. The Drivebar makes 
complete directory and file information just a mouse click away.

Drag And File includes an Uninstaller to remove the program and changes made during 
installation. 

Note:  Microsoft Windows' file-handling requirements may make it necessary for you to delete the 
uninstaller file itself. 

1.2 User Help: Guides and Resources
Drag And File is designed to present options and procedures clearly. The window components, 
including icons, graphic and text buttons, and directory tree displays, make evident what to 
do and how to do it. Along with ease of use and the ordinary features of file management, Drag 
And File offers an unusual degree of sophistication. Several kinds of resources help users at all 
levels learn and use these features.

Online help
The online help system is available at any time by clicking on the Help menu on the menu bar in 
the main window. Context-sensitive help is also available for most menus and dialog boxes. 
For information and procedural help specific to a screen or menu, click on the Help button.

Telephone help
Canyon Software is committed to producing software that is useful and productive. To help users 
make full use of Drag And File, Canyon Software maintains a technical help line for 
registered users from 9 am to 6 pm Pacific Time.

Phone (415) 382-7999
Fax (415) 382-7998
CompuServe 71320,1277
America On Line DanBCan

1.3 Installation 



Requirements
Drag And File is designed to run on an IBM PC-compatible computer with an 80286 or higher 
processor and a minimum of 2 megabytes (4 is recommended) of RAM. The program 
requires 2.5 megabytes of disk space for a typical installation. 

Preliminaries
Before installing Drag And File, make note of the following items.
1. Note the drive and directory where your copies of PKZIP and PKUNZIP are installed. If your 
version of these programs is earlier than 2.04g we recommend that you acquire, install, and 
register the latest versions.
2.  If LHA is your preferred compression program, make note of the drive and directory where it is 
installed.

Installation procedures
1. Power on the computer, load Windows, and open the Program Manager.
2. Insert the Drag And File disk #1 into an appropriate drive.
3. From the Program Manager's File menu, choose Run.
4. In the dialog box, type the designation of the drive in which you inserted the Drag And File 
program disk, followed by "DFSETUP" and press the Enter key.  If the drive is designated B:, the 
Run command would be as follows:

B:DFSETUP

Setup dialog box
5. Choose one of the first two options. Fileman Launcher is a utility which installs as a drop down 
menu from the menu bar. It offers easy access to Drag And View and Drag And Zip and other 
auxiliary programs which work with Drag And File.
Note: The modules which allow you to view files and to zip and unzip files are installed only when 
you choose to install Fileman Launcher. 

When you make your choice and click OK, Drag And File installs automatically, asking you to 
confirm drive installations, and the location of several auxiliary programs and utilities which are 
part of the program. Follow instructions in the dialog boxes which accompany the choices.

The installation program concludes by opening the newly created Drag And File group window, 
showing the icons representing components of the program. 

Uninstall
To remove Drag And File:
Click on the Drag And File setup icon in the Drag and File group in Program Manager.
The setup screen appears. Follow instructions to remove Drag And File.

Note: Microsoft Windows' file-handling requirements may make it necessary for you to delete the 
uninstaller file itself. 

Configuring 
2.1 Setting Preferences
Drag And File offers several ways to tailor the program to meet individual needs. The Setup 
program provides choices which allow you to install Drag And File in a variety of ways. The 
program installs a Setup icon in the Drag And File group window. This icon allows access to the 
Setup program to modify those choices after the program has been installed, to reinstall the 
program, or to uninstall the program.

To make changes in the Setup program:
1. From Program Manager (or whatever Windows shell you use) open the Drag And File group 
window. Double click on the Setup icon. 



2. The Installation dialog box displays.
3. Select one of the first two choices to reinstall Drag And File, with or without Fileman Launcher.
4. Select either of the last two choices to remove part or all of the Drag And File installation.

Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to 
adjust several aspects of the program's performance and display.
To change fonts:
1. Select Fonts from the Options menu. The Fonts dialog box displays. Available fonts are those 
which are installed under Windows, or under a type manager working with Windows.

2. Make whatever changes you wish and click OK. The changes take effect immediately and 
remain when you exit the font dialog box.

To change Settings:
1. Select Settings from the Options menu. The Settings dialog box displays.

2. Enter your choices for warnings, multiple windows operations, window appearance, viewer 
options and overwrite warnings. When overwrite warnings enabled, they appear when the files 
you are copying or moving are about to overwrite files of the same name. 

Multiple Windows: Drag And File lets you perform operations on tagged files in more than one 
window. These choices allow you to specify which operations you would like to perform in multiple
windows.

Window Appearance: These choices follow the pattern for Microsoft Windows: cascaded windows
are overlapped slightly, and tiled windows are fully visible.

Viewer options. Check the first of these options to view a highlighted file automatically, or the third
option to keep the viewing window visible. The second option is selectable if the first option is 
checked.

3. In the box beneath Editor, enter the full pathname (the drive, directory, and full executable 
filename) of your word processor. This information allows Drag And File to load the word 
processor you specify here and open a highlighted or tagged file when you choose Edit File from 
the Actions menu.
4. Click OK to save your changes and exit. Click on Cancel to exit without making changes.

2.3 Drag And File Drivebar
About the Drivebar
Though small and unobtrusive, the Drag And File Drivebar can provide access to all your Drag 
And File functions. The Drivebar consists of a floating bar containing buttons which 
represent your drives, removable and fixed drives, local and networked, and a control bar. Click 
on a drive button to open a new drive window. Click on the control bar to open a menu 
with choices to control the Drivebar display and to close all open Drag And File windows.

The DF Drivebar normally floats in the foreground, above whatever application is current.
To activate the Drivebar, open the Drag And File group window from Program Manager and click 
on the DF Drivebar icon. 

Configuring the Drivebar
The  Drivebar can be altered to fit your needs. 
To configure the Drivebar:
1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.
The control menu appears. 
2. Click on Display Vertically (or Display Horizontally) to select the configuration other than the 



one currently in effect.
3. Click on Always Visible to make the Drivebar appear on top of other programs.
4. Click on Close All Drag And File Windows to close all open Drag And File drive windows, but 
leave the Drivebar icon visible.
5. Click on other choices as needed to Move, Close, open a Help window, or to see information 
about the Drivebar.

2.4 Fileman Launcher
Fileman Launcher is a utility that helps to manage all your Drag and File auxiliary programs, such 
as Drag And View. Fileman Launcher is installed as an option when you install Drag And 
File, and a menu of its choices is accessible by clicking on Fmlaunch in the Drag And File menu 
bar.

Fmlaunch menu
Using the Fmlaunch menu you can do the following: 
Add and delete items to the list programs that Fileman Launcher runs. Fileman Launcher can run 
up to 12 programs with Drag And File
Change how the programs are run.
Add command line arguments to the programs
Quit all the programs 
Rerun the programs

Using Drag And File
3.1 Drag And File Main Window
The Drag And File window is divided into several functional and information sections. Drag And 
File can open up to twelve windows simultaneously.

Drag And File main window
The menu bar contains drop down menus. They are accessible with a mouse or directly from the 
keyboard by using the Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of directories 
on this drive, the space remaining on the drive, the files in the selected directory, and 
their total size.

Note: Drive data may be incorrect for compressed drives.

The drive buttons allow you to choose which drive information the open window displays. Double 
clicking on the icon of the currently displayed drive opens a second window displaying 
that drive. The lower half of the window is divided into two panes: information in the left pane 
concerns directories, and information about files appears in the right pane.

Choosing files and directories
Drag And File, unlike Microsoft Windows File Manager, allows you to select and work with 
directories in the same way that you select and work with files.

Drag And File marks files and directories by highlighting, tagging, and dotting.
Highlight files and directories by left clicking on them with the mouse or by using the arrow keys 
to move the highlight bar up or down over a listing. Only one directory or file can 
be highlighted at a time. Operations like Copy or Move can be performed on a highlighted file by 
clicking the appropriate tool, or by using drop down menus or keyboard shortcut keys. If any files 
are tagged, highlighting is ignored.

Tag and untag files or directories by several methods:
Right click with the mouse to tag and untag; Shift-Left click to tag contiguous groups of files or 
directories. Right arrow to tag; left arrow to untag. Spacebar and Ctrl-Right click to toggle tagging 
on or off.



Dots mark files which have been copied. Dotted files may be reselected as a group for other 
operations.

Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include 
information about shortcut key combinations to activate commands from the keyboard.
Drag And File includes in its menu bar extensions-drop down menus inserted in the File 
Manager's menu bar by utility and other programs. Examples include the Stacker file 
compression program, and the Microsoft Backup, AntiVirus, and DoubleSpace programs.

Drive bar
The drive bar includes buttons that represent all accessible drives.

Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.

Directory pane
The directory pane displays, in a tree format, all directories and subdirectories of the currently 
selected drive.

File pane
The file pane displays a list of the files and their attributes contained within the currently selected 
directory or subdirectory.

3.2 Search function
To locate a specific directory or file, when the appropriate pane is active, start typing the name of 
the directory or file. Your typing appears in a small window that opens over the directory 
count in the lower left corner of the window, beneath the directory pane. As you type, the highlight
bar will move to the directory or file which most closely approximates your typing.

Managing Files: 
Drag And File uses all the mouse conventions associated with Microsoft Windows programs.
When you drag and drop files and directories to a directory or drive button, a dialog box opens. 
Using options in the dialog box you can specify a Copy or Move operation, the name of the file or 
directory, and use a browse feature to specify the path.

Toolbar functions
Drag And File's toolbar contains buttons which make the most common file management tasks 
easily accessible.

Toolbar
View functions
The View button differs from the other buttons on the toolbar: it opens a view window with its own 
toolbar. The view window and toolbar buttons vary according to which pane (directory or 
file)  was active when the View button was pressed. In addition, if the file pane was active, 
available buttons in the viewing window depend on what kind of file was highlighted or tagged.

Directory view
If the directory pane was active, the View button opens a list window to view an alpha ordered list 
of files contained in the highlighted directory or in the tagged directories. The toolbar in the 
Directory view window replaces the New button with a unique Dupes button. Clicking on the 
dupes button liists only duplicate files in the highlighted or tagged directories. 

This function allows you to search a directory, a branch, or a whole drive for duplicate files. 
When this function is active, the words Duplicate Files appear in the search window in the lower 



left section.

File view
If the file pane was active, the View button opens a Drag And View window to view the contents of
the highlighted file or the first of several tagged files. The view window uses viewers to 
display files in native format, or in a form as close as possible. Drag And View will also display 
readable files in ASCII format and any file in its hexadecimal format. In addition, Drag And View 
plays sound files (those with a .WAV extension).

List All Files
One feature unique to Drag And File is the ability to view listings of the files on an entire drive or 
combinations of drives.  Click on the file menu and choose List All Files.  From the dialog box 
choose the drives that you want to view.  Click enter and a window dislplaying those files will 
come up.  The button bar in that window is similar to the main Drag And File window with one 
exception.  The Mk Dir button has been replaced with a Dupes button.  Clicking on the Dupes 
button will toggle on and off the display of just diplicate files.

Multi Associate
Use the Multi Associate command to associate more than one program with filenames of a 
specified extension. If you want to choose among different word processors to edit files with a 
.TXT extension, for example, you would use this command to list those word processors.
When you double click on a file with such an extension, Drag And File opens a dialog box which 
allows you to choose one of the designated programs associated with this filename extension.
To record mutiple associations:
1. Click on the Multi Associate option from the File menu.
2. Type the full pathname (including drive, directory, and filename) of the new program.

-OR-
Click on Browse to select a program file from another directory.
3. Click Add to add the program to those displayed in the current associations window.
4. Click OK to close the window and record your choices.


